
 

SharePoint Products 2013 Keyboard Shortcuts 

Navigating the ribbon 

You can use the keyboard to work with the ribbon by moving the focus among the tabs and commands until you find the 

feature that you want to use. The following table lists some ways to move the keyboard focus without using the mouse. 

To do this Press 

Move left or right to another tab of the Ribbon, respectively. TAB to reach the desired tab, and then LEFT 

ARROW, RIGHT ARROW 

Display the shortcut menu for the selected command. ENTER 

Move the focus to each command on the Ribbon, forward or 

backward. 

TAB, SHIFT+TAB 

Move down, up, left, or right among the items on the Ribbon. DOWN ARROW, UP ARROW, LEFT ARROW, RIGHT 

ARROW 

Activate the selected command or control on the Ribbon. SPACE BAR or ENTER 

Open the selected menu or gallery on the Ribbon. SPACE BAR or ENTER 

Activate a command or control on the Ribbon so you can change a 

value. 

ENTER 

Finish changing a value in a control on the Ribbon, and move the 

focus back to the document. 

ENTER 

Top of Page 

All pages 

The following table describes keyboard shortcuts that apply to all pages in SharePoint products and technologies. 

To do this Press 

Turn More Accessible Mode on or off. 

More Accessible Mode changes the way content is rendered on a site, optimizing it 

for assistive technologies such as screen readers. 

TAB (Press repeatedly, immediately 

after you open the page in a 

browser.) 

Activate or put the focus on the Skip Ribbon Commands link. ALT+Y 

Activate or put the focus on the View All Site Content link. ALT+3 

Activate or put the focus on the Site Actions menu. ALT+/ 

Activate or put the focus on the Search box. 

To put the focus on the Search box, the ribbon has to have the active focus. Press 

ALT+/ to place focus on the Site Actions menu, and then press TAB repeatedly until 

the focus is placed on the Browse tab. 

ALT+S 

Activate or put the focus on the Help link. ALT+6 

Activate or put the focus on the Home link. ALT+1 
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Activate or put the focus on the Your Name menu. 

Press ALT+W multiple times to switch between the Your Name menu and any Web 

Parts on the page. 

ALT+W 

Expand menus such as the drop-down menu for a list item. SHIFT+ENTER 

Expand drop down lists such as the Search Scope menu next to the Search box at 

the top of some pages. 

ALT+DOWN ARROW 

Move the selection from Web Part to Web Part on pages that use multiple Web 

Parts 

ALT+W 

Top of Page 

Common tasks on SharePoint pages 

Edit Rich text 

Rich text editing is available in several locations, such as the ribbon for a publishing page or the Content Editor Web Part.  

To do this Press 

Change the text color. 

This requires the ribbon to have the active focus. Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the Format Text 

tab under Editing Tools. 

TAB (Press repeatedly until the Font 

Color menu is selected.) 

Change the text size. 

This requires the ribbon to have the active focus Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the Format Text 

tab under Editing Tools. 

TAB (Press repeatedly until the Font 

Size menu is selected.) 

Change the text font. 

This requires the ribbon to have the active focus Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the Format Text 

tab under Editing Tools. 

TAB (Press repeatedly until the Font 

menu is selected.) 

Apply or remove bold formatting from the selected text. CTRL+B 

Apply or remove italic formatting from the selected text. CTRL+I 

Apply or remove the underline from the selected text. CTRL+U 

Change the highlight color of text. 

This requires the ribbon to have the active focus. Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the Format Text 

tab under Editing Tools. 

TAB (Press repeatedly until the 

Highlight Color button is selected.) 

Left align the selected paragraph. CTRL+L 

Center the selection. CTRL+E 

Right align the selected paragraph. CTRL+R 
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Convert the selection to a left-to-right orientation. CTRL+SHIFT+ > 

Convert the selection to a right-to-left orientation. CTRL+SHIFT+ < 

Create a numbered list. 

This requires the ribbon to have the active focus. Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the Format Text 

tab under Editing Tools. 

TAB (Press repeatedly until the 

Numbered List button is selected.) 

Apply or remove bulleted list formatting from the selected paragraph. 

This requires the ribbon to have the active focus. Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the Format Text 

tab under Editing Tools. 

TAB (Press repeatedly until the 

Bulleted List button is selected.) 

Remove a paragraph indent from the left. CTRL+SHIFT+M 

Indent a paragraph from the left.  CTRL+ M 

Delete the selection without adding it on the Clipboard. DELETE 

Switch between inserting and overwriting text. INSERT 

Delete the selection, or if there is no selection, the character in front of the cursor. BACKSPACE 

Delete all of the word in front of the cursor, but not the previous space. CTRL+BACKSPACE 

Insert a new line (but not inside the HTML Paragraph element <P>). SHIFT+ENTER 

Top of Page 

Pages or dialog boxes that have Open or Cancel buttons 

To apply or cancel edits in pages or dialog boxes that have Open, Save, Create or Cancel buttons, use the following 

keyboard shortcuts. Such dialog boxes and pages include such New Alert, Upload Document, or New Library. 

To do this Press 

Cancel button (cancels changes and returns to the list, library, discussion board, or survey)  ALT+C 

Depending on the context, the OK, Save or Create button (saves changes and closes the page or dialog box.) ALT+O 

Top of Page 

List or library page 

To do this Press 

Create a document. Press TAB repeatedly until the item that you want is 

selected. 

In a library, the ribbon button name may be New 

document. In a list, the ribbon button name may be New 

item, or a name specific to the type of list, such as Add 

new link. 
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Upload a document. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

Press TAB repeatedly until the link that you want is 

selected. 

In a library, the command may be Add new document or 

Add new item. In a list, the command may be Add new 

item or specific to the type of list, such as Add new link. 

Edit a page in Datasheet view. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until Datasheet View is selected on 

the List or Library tab.) 

Open an item with File Explorer. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until Open with Explorer is selected 

on the List or Library tab.) 

Export a list to Microsoft Excel 2010. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until Export to Excel is selected on 

the List or Library tab.) 

View the RSS feed for the library. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until RSS Feed is selected on the List 

or Library tab.) 

Create an alert for the library. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until Alert Me is selected on the List 

or Library tab.) 

Create a column. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until Create Column is selected on 

the List or Library tab.) 

Create a view. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until Create View is selected on the 

List or Library tab.) 

Change the library settings. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until Library Settings is selected on 

the List or Library tab.) 



 

Create a folder. 

This requires the ribbon to have the active focus. Press ALT+/ 

to place focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the ribbon tab that you want. 

TAB (Press repeatedly until New Folder is selected on the 

List or Documents tab.) 

Expand the menu of options for a document in a library. 

This requires the main content area to have the active focus 

(Press ALT+X). 

TAB. Press TAB repeatedly until you select the arrow on 

the menu, and then press ENTER. 

Filter a column in a list. 

This requires the main content area to have the active focus 

(Press ALT+X) to place focus in the main content area, and 

then press TAB repeatedly) 

TAB (Press TAB repeatedly until you select the arrow on 

the menu, and then press ENTER. 

Top of Page 

Slide library page 

To do this Press 

Upload slides. 

This requires the main content area to have the 

active focus (Press ALT+X). 

TAB (Press TAB repeatedly until you select the Upload menu, and then 

press DOWN ARROW to select Publish Slides. 

Delete slides. 

This command is located on the Actions menu. 

TAB (Press repeatedly until you select the Actions menu, and then 

press DOWN ARROW to select Delete. 

Copy slide to a presentation. ALT+N 

Top of Page 

Picture library page 

To do this Press 

Activate or put the focus on the Edit command. 

This command is located on the Actions menu. 

ALT+C (To start the menu, press SHIFT+ENTER. To select a command, 

press DOWN ARROW.) 

Activate or put the focus on the Delete 

command.  

This command is located on the Actions menu. 

ALT+C (To start the menu, press SHIFT+ENTER. To select a command, 

press DOWN ARROW.) 

Activate or put the focus on the Download 

command. 

This command is located on the Actions menu. 

ALT+C (To start the menu, press SHIFT+ENTER. To select a command, 

press DOWN ARROW.) 

Activate or put the focus on the Send To 

command. 

This command is located on the Actions menu. 

ALT+C (To start the menu, press SHIFT+ENTER. To select a command, 

press DOWN ARROW.) 

http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top
http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top
http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top
http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top


 

Activate or put the focus on the View Slide 

Show command. 

This command is located on the Actions menu. 

ALT+C (To open the menu, press SHIFT+ENTER. To select a command, 

press DOWN ARROW.) 

Top of Page 

Survey page 

To do this Press 

Activate or put the focus on the Actions menu. ALT+C (To open the menu, press SHIFT+ENTER. To select a 

command, press DOWN ARROW.) 

Activate or put the focus on the Respond to this 

Survey button. 

ALT+N 

Activate or put the focus on the Export Results to 

spreadsheet command. 

This command is located on the Actions menu. 

ALT+C (To open the menu, press SHIFT+ENTER. To select a 

command, press DOWN ARROW.) 

Activate or put the focus on the Show a graphical 

summary of responses link. 

ALT+R 

In a form for editing a survey response, select the Save 

and Close button. 

ALT+S 

Activate or put the focus on the Show all responses 

link. 

ALT+U 

Activate or put the focus on the Settings menu. ALT+I 

Activate or put the focus on the Next Page button. ALT+N 

Top of Page 

Permissions page 

To do this Press 

Grant users permissions. 

This requires the ribbon to have the active focus. Press ALT+/ to place focus on 

the Site Actions menu, and then press TAB repeatedly until you reach the 

ribbon tab that you want. 

TAB (Press repeatedly until you select 

the Grant Permissions button on the Edit 

tab.) 

Create a group. 

This requires the ribbon to have the active focus. Press ALT+/ to place focus on 

the Site Actions menu, and then press TAB repeatedly until you reach the 

ribbon tab that you want. 

TAB (Press repeatedly until you select 

Create Group on the Edit tab.) 

Remove user permissions.  TAB (Press repeatedly until you select 

Remove User Permissions on the Edit 

tab.) 
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This requires the ribbon to have the active focus. Press ALT+/ to place focus on 

the Site Actions menu, and then press TAB repeatedly until you reach the 

ribbon tab that you want. 

Edit user permissions.  

This requires the ribbon to have the active focus. Press ALT+/ to place focus on 

the Site Actions menu, and then press TAB repeatedly until you reach the 

ribbon tab that you want. 

TAB (Press repeatedly until you select 

Edit User Permissions on the Edit tab.) 

Check Permissions.  

This requires the ribbon to have the active focus. Press ALT+/ to place focus on 

the Site Actions menu, and then press TAB repeatedly until you reach the 

ribbon tab that you want. 

TAB (Press repeatedly until you select 

Check Permissions on the Edit tab.) 

Top of Page 

All Site Content page 

To do this Press 

Activate or put the focus on the Create link. ALT+N 

Top of Page 

Discussion board 

To do this Press 

Activate or put the focus on the Add new discussion link.  

This requires the main content area to have the active focus 

(Press ALT+X). 

TAB (Press repeatedly until you reach the Add new 

discussion link.) 

Top of Page 

Calendar view 

To do this Press 

Activate or put the focus on the Day view link  

This requires the ribbon to have the active focus. Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the ribbon tab that 

you want. 

TAB (Press repeatedly until you 

select Day on the Calendar tab.) 

Activate or put the focus on the Week view link 

This requires the ribbon to have the active focus. Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the ribbon tab that 

you want. 

TAB (Press repeatedly until you 

select Week on the Calendar tab.) 

Activate or put the focus on the Month view link TAB (Press repeatedly until you 

select Month on the Calendar tab.) 
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This requires the ribbon to have the active focus. Press ALT+/ to place focus on the 

Site Actions menu, and then press TAB repeatedly until you reach the ribbon tab that 

you want. 

In a date picker control, move to the previous month ALT+< 

In a date picker control, move to the next month  ALT+> 

Top of Page 

Web Part Page 

To do this Press 

Move to the next Web Part. ALT+W 

Open the Web Part menu.  

This requires that the Web Part have the active focus. Press ALT+X to skip to the main 

content, then press ALT+W repeatedly until you select the title for the Web Part that you 

want. Press TAB to select the menu. 

ENTER 

Edit a Web Part.  

This requires that the Web Part menu have the active focus. Press ALT+W repeatedly until 

you select the title for the Web Part that you want, press TAB, and then press ENTER. 

TAB (Press repeatedly until 

Edit Web Part is selected) 

Save property changes in the Web Part tool pane, and then close the tool pane. ALT+O 

Save property changes in the Web Part tool pane, and keep the tool pane open. ALT+Y 

Cancel property changes in the Web Part tool pane, and then close the tool pane. ALT+C 

Add the selected Web Part in the Add Web Parts pane to a Web Part Page. TAB (Press repeatedly until 

Add is selected) 

Move to the previous item in a drop down list, menu, or submenu. UP ARROW 

Move to the next item in a drop down list, menu, or submenu. DOWN ARROW 

Top of Page 

Managing Microsoft InfoPath forms in a library 

To do this Press 

Merge forms 

This requires the ribbon to have the active focus. Press ALT+/ 

to put the focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the Library tab on the ribbon. 

Press TAB repeatedly until the Current View menu is 

selected, and then press DOWN ARROW several times to 

select Merge Documents. 

Edit a form in Microsoft InfoPath 2010 

This requires the main content area to have the active focus 

(Press ALT+X). 

TAB (Press repeatedly until you select the arrow on the 

menu for the form. Press ENTER and then press DOWN 

ARROW to select Edit in Microsoft InfoPath.) 
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Edit a form in the browser  

This requires the main content area to have the active focus 

(Press ALT+X). 

TAB (Press repeatedly until the downward pointing arrow 

on the menu for the form is selected. Press ENTER and 

then press DOWN ARROW to select Edit in Browser.) 

Create a new form in a library  

This requires the ribbon to have the active focus. Press ALT+/ 

to put the focus on the Site Actions menu, and then press TAB 

repeatedly until you reach the Documents tab on the ribbon. 

Press TAB repeatedly until New Document is selected. 

For more information about keyboard shortcuts that you can use in InfoPath forms, see Keyboard shortcuts for InfoPath 

2013. 

Top of Page 

Syncing folders with OneDrive for Business 

When you are on a corporate network, you can use OneDrive for Business to sync folders on your computer with their 

corresponding SharePoint libraries. After the initial sync, OneDrive for Business syncs folders automatically.  

The following sections describe the keyboard shortcuts that you can use to work with OneDrive for Business. 

Accessing the OneDrive for Business menu in the Windows system tray 

The OneDrive for Business menu is accessed from an icon in the system notification tray (systray). To access the menu, 

follow these steps. 

To move keyboard focus to the systray, press Win+B 

Press ENTER or SPACEBAR to open the systray. 

Press the UP arrow to move into the icon window, and then use the arrow keys to browse through the available icons 

until you find OneDrive for Business.  

Press ENTER to open the OneDrive for Business menu. 

Press  

Top of Page 

Keyboard shortcuts for OneDrive for Business menu  

The following table describes the keyboard shortcuts that you can use to operate the OneDrive for Business menu. 

To do this Press 

Open OneDrive for Business in browser O  

Sync a new lib  S 

Sync all folders N 

Pause OneDrive for Business syncing P 

Resume OneDrive for Business syncing R 

Stop syncing a folder T 

http://office.microsoft.com/en-us/sharepoint-server-help/redir/HA103306377.aspx?CTT=5&origin=HA102772894
http://office.microsoft.com/en-us/sharepoint-server-help/redir/HA103306377.aspx?CTT=5&origin=HA102772894
http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top
http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top
http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top
http://office.microsoft.com/en-us/sharepoint-server-help/keyboard-shortcuts-for-sharepoint-products-HA102772894.aspx#top


 

Open help H 

Exit OneDrive for Business X 

Top of Page 

Explorer shortcuts to use with OneDrive for Business 

You can access some keyboard shortcuts for OneDrive for Business from File Explorer. To use these shortcuts, first follow 

these steps: 

Open File Explorer, and then go to the folder that you want. 

Select the file or folder that you want to work with. 

Right click to open the File menu. The File menu contains OneDrive for Business as an option. 

The following table shows the shortcuts that you can use after you open the File menu. 

To do this Press 

Start OneDrive for Business S 

Go to browser G 

Copy link C 

Share S 

View sync problems V 

Top of Page 

Getting Help 

The Help window displays topics and other Help content. The following table describes keyboard shortcuts that you can 

use with the Help window. 

To do this Press 

Open the Help window. ALT+6 

Close the Help window. ALT+F4 

Switch between the Help window and the active program. ALT+TAB 

Perform the default action for the selected item. ENTER 

In the Help and how-to window, select the next or previous item. TAB or SHIFT+TAB 

In the Help topic, expand or collapse the selected item. ENTER 

Select the next hidden text or hyperlink. This includes Show All or Hide All at the top of a 

topic. 

TAB 

Select the previous hidden text or hyperlink. SHIFT+TAB 

Perform the action for the selected Show All, Hide All, hidden text, or hyperlink. ENTER 
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Move back to the previous Help topic (Back button). ALT+LEFT ARROW or 

BACKSPACE 

Move forward to the next Help topic (Forward button). ALT+RIGHT ARROW 

Scroll small amounts up or down within the currently displayed Help topic. UP ARROW, DOWN ARROW 

Scroll larger amounts up or down within the currently displayed Help topic. PAGE UP, PAGE DOWN 

Stop the last action (Stop button). ESC 

Refresh the window (Refresh button). F5 

Print the current Help topic. 

 Note   If the current Help topic is not the active window, press ALT+F6, and then press 

CTRL+P. 

CTRL+P 

Type text in the search box. TAB (Press repeatedly) 

Select the previous hyperlink.  SHIFT+TAB 

Print the current Help topic. CTRL+P 

 


